IFC-guide
Innehåll

Introduktion.................................................................................................................. 1
1. Ordlista för IFC-relaterade begrepp ........................................................................ 2

2. Grundkunskaper IFC .................................................................................................. 5
2.1. IFC Elementtyp och klassificering ........................................................................ 5
2.2. IFC filtyper .............................................................................................................. 8
2.3. IFC kommandon ...................................................................................................... 8

3. Modellera korrekt ....................................................................................................... 9
3.1. Våningar .................................................................................................................. 9
3.2. Vanliga fel .............................................................................................................. 10
3.3. Klassificering av byggdeler med BSAB-koder ...................................................... 11
3.4. Utrymmen/zoner (ifcSpace) ................................................................................ 13
3.5. Vägghöjder ............................................................................................................ 15
3.6. Klassificering och ID-kodning av element ........................................................... 16
3.7. Avancerad modelleringsteknik .......................................................................... 19

4. IFC-import .................................................................................................................. 20
4.1. Translators ............................................................................................................ 20
4.2. Importera: Open and Merge .............................................................................. 27
4.3. Importera IFC – steg-för-steg instruktion ............................................................ 28

5. IFC Export-inställningar ............................................................................................ 29
5.1. IFC Export Settings ............................................................................................. 29
5.2. Exportera: Save as IFC ...................................................................................... 34
5.3. Export - använda ARCHICADs Publisher ............................................................. 35
5.4. IFC Space Boundaries (zongränser) .................................................................. 37
5.5. Model Filter ........................................................................................................... 38

6. Fler IFC-funktioner .................................................................................................... 39
6.1. Hotlink IFC ............................................................................................................. 39
6.2. Detect IFC Model Changes ................................................................. 40
6.3. Merge to IFC Model ......................................................................... 43
6.4. IFC Manager ..................................................................................... 43
6.5. Create New Property ........................................................................ 45
6.6. Import Custom IFC Property Set ....................................................... 46

7. Kontroll och kvalitetssäkring ................................................................. 46
7.1. Viewer .............................................................................................. 47
7.2. Checker ............................................................................................. 47
7.3. ARCHICAD/Solibri Add-on ............................................................... 47
7.4. Information i IFC-filer ................................................................. 55
7.5. BIM Collaboration Format ................................................................. 56
7.5.1. Exempel BCF-kommunikation ................................................... 57

8. IFC – rekommendationer (Best practice) .................................................. 61
8.1. Arbetsflöde IFC-Export från ARCHICAD ....................................... 61
8.2. Arbetsflöde IFC-Import till ARCHICAD ......................................... 65
8.2.1. Hantera attribut för importerade IFC-filer ................................. 66
8.3. Multidisciplinära projekt .............................................................. 66
8.3.1. 3D-samgranskning med hjälp av IFC-formatet ....................... 68
Introduktion

IFC (Industry Foundation Classes) är ett neutralet och öppet filformat som möjliggör informationsutbyte mellan olika CAD-program och andra mjukvaror inom bygg och förvaltning. IFC-formatet är ISO-certifierat och kan integreras i det kvalitetssäkringssystem som ditt kontor har valt. IFC är utvecklat av IAI (International Alliance for Interoperability) som idag har mer än 600 medlemsföretag runt om i världen. För mer information se:

http://www.buildingsmart.com/

GRAPHISOFT har spelat en aktiv roll inom IAI sedan 1996 och stödjer IFC-standarden vilket ger ARCHICAD möjlighet att kommunicera med andra discipliner och att koordinera byggnadsprojekt per objekt i 3D. Byggnodellen kan exporteras till hundratal andra system som stödjer IFC.

BIM, eller Building Information Modeling, är en av de största landvinningarna inom byggbäcksens arbetsmetoder sedan introduktionen av CAD. Det är viktigt att BIM inte ses som synonymt med 3D. Geometrisk representation av byggnadselement i 3D (3D-CAD) är bara en av delarna i BIM-konceptet. Ett verkligt projekt innehåller icke-grafisk information som beräkningar och mångsidiga förutsättningar för utvärdering, förvaltning, energieräkningar, akustik med mera. En förutsättning för ett effektivt BIM-projekt är att intelligent information kan växlas mellan olika mjukvaror (och operativsystem) genom alla skeden i byggningsprocessen. Denna interoperabilitet kräver ett neutralet och öppet filformat som alla mjukvaror kan använda och som också ågs samt utvecklas av branschen och inte av specifika mjukvaruleverantörer. IFC är ett dylikt system som gör det möjligt att synkronisera byggnadsmönster mellan mjukvaror och discipliner på ett effektivt sätt.

Med ett användarvänligt gränssnitt och stora möjligheter till anpassning är ARCHICADs IFC-funktioner enkelt åtkomliga och kan användas av både proffs och nybörjare.

Denna guide ger inblick i själva IFC-standarden samt hur den fungerar i ARCHICAD. IFC-versionen för exempelvis ARCHICAD 21 är IFC2x3, Coordinate View-version 2.0 (IFC2x3 CV 2.0). Det finns även stöd för version IFC2x4.

1. Ordlista för IFC-relaterade begrepp

**Attribute**
Attribut definierar en IFC entity. Ett markerat elements attribut kan visas och kontrolleras med ARCHICADs IFC-manager. IfcWall har som exempel följande attribut: GlobalID (=IFC GUID), Name, Description, ObjectType och Tag (tag=märkning och utgörs default av ARCHICADs GUID).

**BCF**
BIM Collaboration Format är ett öppet filformat som introducerar ett arbetsflöde med kommunikationsförmåga ansluten till IFC-modeller.

**BIM**
Building Information Modeling avser processer för att hantera information i hela eller delar av en byggnadsmodells livscykel.

**BIM-kordinator**
En person som är ansvarig för att se till att BIM planen följs. BIM-kordinatorn är också ofta ansvarig för att kontrollera informationsnivån och kvalitén på modellerna från olika discipliner, samt att kontrollera byggarbarheten.

**BIM-plan**
Även kallad BIM-genomföringsplan (av engelskans BIM Execution Planning). Planen beskriver hur BIM-projektet är tänkt att genomföras med tanke på
informationshantering, informationsutväxling, disponering av resurser och kompetenser, beroenden mellan olika projektdelegarer och så vidare.

BIP Building Information Properties är egenskaper med gemensamma beteckningar på byggdelar för att ge ett effektivare informationsflöde mellan projektörer, byggare, installatörer, drift och förvaltning.

BuildingSMART BuildingSMART (Tidigare IAI, International Alliance for Interoperability) är organisationen som på uppdrag från ISO vidareutvecklade IFC-standarden.

CAD CAD är en förkortning för Computer Aided Design, vilket i byggsammanhang bör översättas med datorstödd projektering.

Filformat Med filformat avses den interna struktur som datafiler hyser.

GUID Globally Unique Identifier är en global unik identifierare som används i datorprogram, en textsträng kopplad till varje unikt element för att de ska kunna identifieras. GUID gör det möjligt för olika datorprogram att identifiera samma element. ARCHICADs interna GUID är inte samma som IFC-GUID för ett element.

Information Information är en generell beteckning för det meningsfulla innehåll som överförs vid kommunikation i olika former.

IFC IFC är en förkortning för Industry Foundation Classes, en standard för att utbyta information inom husbyggnadsprojekt. Den omfattas av en strukturerad begreppsmodell.

IFC Entity Projektinformation från ARCHICAD som sparas till IFC representeras av "entities", exempelvis element, material och deras relationer. Varje entitet, exempelvis en ifcWall, har ett bestämt antal attribut plus obegränsat antal ytterligare egenskaper.

LOD Level of Development definierar nivån på innehållet och pålitligheten i exempelvis en BIM-modell vid olika tidpunkter och faser.

Modellering Modellering är en process i syfte att skapa en modell.

MVD Model View Definition definierar en delmängd i IFC-schemat som behövs för att tillfredsställa ett visst informationsutbyte.

Neutralt format Ett överföringsformat för digital information som inte är plattformsberoende.
**Objektmodell**

Objektmodeller beskriver den studerade verkligheten som objekt och sambandet mellan dessa. Exempel på objektmodeller i bygg- och fastighetssammanhang är så kallad bygginformationsmodeller (BIM), som beskriver byggnaden och dess delar under dess livscykel. På samma sätt finns det för andra typer av produkter motsvarande modeller.

**Property**


IFC Manager ger användaren möjlighet att se innehållet i och editera *property sets*. Det går även att skapa nya standardproperties samt *custom properties* som kan användas vid IFC-exporten.
Obs: Följande IFC-properties, som bestäms av klassifikation i ARCHICAD, kan inte modifieras i IFC Manager: *IsExternal* (bestäms genom klassificeringen ”Position”). *Load-Bearing* (bestäms genom klassificeringen ”Structural Function”).

2. Grundkunskaper IFC

2.1. IFC Elementtyp och klassificering

Varje byggeelement (2D och 3D) i ARCHICAD har en direkt mappning till sin motsvarighet i IFC-strukturen (IFC Element Type). Följande tabell visar standardkopplingen från ARCHICAD till IFC.

<table>
<thead>
<tr>
<th>ArchICAD Element type</th>
<th>IFC Element type</th>
<th>ArchICAD Element type</th>
<th>IFC Element type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Wall</td>
<td>Obj Wall StandardCase</td>
<td>Wall</td>
<td>Wall</td>
</tr>
<tr>
<td>Door</td>
<td>RE:door</td>
<td>Door</td>
<td>Door</td>
</tr>
<tr>
<td>Window</td>
<td>RE:window</td>
<td>Window</td>
<td>Window</td>
</tr>
<tr>
<td>Skylight</td>
<td>RE:window</td>
<td>Object: Opening</td>
<td>BuildingElementFlow</td>
</tr>
<tr>
<td>Roof</td>
<td>RE:roof</td>
<td>Object: Roof</td>
<td>Roof</td>
</tr>
<tr>
<td>Beams</td>
<td>RE:beams</td>
<td>Object: Beam</td>
<td>Beam</td>
</tr>
<tr>
<td>Column</td>
<td>RE:column</td>
<td>Object: Column</td>
<td>Column</td>
</tr>
<tr>
<td>Slab</td>
<td>RE:slab</td>
<td>Object: Slab</td>
<td>Slab</td>
</tr>
<tr>
<td>stair</td>
<td>RE:stair</td>
<td>Object: Stair</td>
<td>Stair</td>
</tr>
<tr>
<td>Ramp (Stair Match)</td>
<td>RE:stair</td>
<td>Object: Precast Stair</td>
<td>Stair</td>
</tr>
<tr>
<td>Mesh</td>
<td>RE:mesh</td>
<td>Object: Plate</td>
<td>Wall</td>
</tr>
<tr>
<td>CurtainWall</td>
<td>RE:CurtainWall</td>
<td>Object: CurtainWall</td>
<td>CurtainWall</td>
</tr>
<tr>
<td>Zone</td>
<td>RE:zone</td>
<td>Object: Tension</td>
<td>Tension</td>
</tr>
<tr>
<td>Dimension</td>
<td>RE:annotation</td>
<td>Object: Stair</td>
<td>Stair</td>
</tr>
<tr>
<td>Level Dimension</td>
<td>RE:annotation</td>
<td>Object: Stair Flight</td>
<td>StairFlight</td>
</tr>
<tr>
<td>Text</td>
<td>RE:annotation</td>
<td>Object: Ramp</td>
<td>Ramp</td>
</tr>
<tr>
<td>Label</td>
<td>RE:annotation</td>
<td>Object: Railing Flight</td>
<td>RailingFlight</td>
</tr>
<tr>
<td>Gate</td>
<td>RE:ann</td>
<td>Object: Curtain Wall</td>
<td>CurtainWall</td>
</tr>
<tr>
<td>Arch/Cove</td>
<td>RE:annotation</td>
<td>Object: Furnishing</td>
<td>FurnishingElement</td>
</tr>
<tr>
<td>Window</td>
<td>RE:window</td>
<td>Object: Wood Frame</td>
<td>WoodFrame</td>
</tr>
<tr>
<td>Grid Element</td>
<td>RE:grid</td>
<td>Object: Foundation</td>
<td>Foundation</td>
</tr>
<tr>
<td>Grid System</td>
<td>RE:grid</td>
<td>Object: footing</td>
<td>Footing</td>
</tr>
<tr>
<td>Wall End</td>
<td>RE:wall</td>
<td>Object: Space</td>
<td>Space</td>
</tr>
<tr>
<td>Corner/Window</td>
<td>RE:window</td>
<td>Object: Covering</td>
<td>Covering</td>
</tr>
<tr>
<td>Lamp</td>
<td>RE:lightTerminal</td>
<td>Object: ReinforcingBar</td>
<td>ReinforcingBar</td>
</tr>
<tr>
<td>Radial Dimension</td>
<td>RE:radialAnn</td>
<td>Object: ReinforcingMesh</td>
<td>ReinforcingMesh</td>
</tr>
<tr>
<td>Angle Dimension</td>
<td>RE:ann</td>
<td>Object: Wall End</td>
<td>Wall</td>
</tr>
<tr>
<td>Slab</td>
<td>RE:ann</td>
<td>Object: ElectricalElement</td>
<td>FlowTerminal</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Object: FlowFitting</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Object: FlowTerminal</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Object: FlowSegment</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Object: TransportElement</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Object: Mechanical</td>
</tr>
</tbody>
</table>
I vissa fall behöver användaren modellera element som inte har en direkt motsvarighet i ARCHICADs verktygslåda. Exempelvis kan bjälklagsverktyget användas för att modellera ett undertak. Vid export till IFC kommer i detta fall undertaket automatiskt bli definierat som IfcSlab. ARCHICAD har dock ett effektivt hjälpmedel för att modifiera IFC-definitionen genom att markera bjälklaget och i Settingsfönstret välja IFC Element Type = Ceiling enligt bild på nästa sida.

Det är alltså mycket enkelt att modifiera IFC-klassificeringen i din ARCHICAD-modell. I de fall en IFC-modell importeras från exempelvis konstruktionen kan IFC Manager användas för att ”fråga” vilket IFC Element Type som elementet har, se bild nedan. IFC Manager beskrivs i den avancerade delen av guiden.
Obs:

- Element som importeras till ARCHICAD och inte har någon motsvarighet i ARCHICAD konverteras till Objekt (till exempel objekt av balktyp eller ytskiktstyp).

Ytterligare klassificering

Element kan, utöver IFC Element Type, klassificeras (och därmed filtreras) som exteriöra/interiöra samt bärande/icke-bärande.

2.2.IFC filtyper
ARCHICAD öppnar och sparar IFC i formaten 2x3 och 2x4. Tidigare IFC-format, exempelvis 2x och 2x2, fungerar också men de bör endast användas om det krävs på grund av annan applikation som inte har stöd för 2x3.

I ARCHICADs dialogfönster för öppna/spara finns det olika IFC-format:

- **.ifc**  
  IFC 2x3 file - normal okomprimerad.
  IFC 2x4 file - normal okromprimerad. Ett nytt förbättrat format som ARCHICAD stödjer.

- **.ifcxml**  
  IFC 2x3 XML file - rekommenderas när det i projektet förekommer andra applikationer som inte kan läsa normal IFC men som kan importera xml-databasen (exempelvis kalkyloidprogram och energiberäkningsprogram). ifcxml är ett okomprimerat format.

- **.ifczip**  
  IFC/IFCXML 2x3 compressed file - komprimerad version av både IFC- och xml-varianten. Ifczip ger en fil med en storlek på 25% av normal export (Tekla Structures har stöd för ifczip).

2.3.IFC kommandon
En IFC-Addon installeras automatiskt vid ARCHICAD-installationen. Nya versioner av IFC läggs kontinuerligt ut efterhand som nya funktioner och buggfixar sker på följande hemsida:

http://www.graphisoft.com/ifc/

Följande IFC-relaterade kommandon finns tillgängliga genom menyn File.

- Open
- Save as
- Merge
- IFC Project Manager
- IFC Translators
- IFC Local Preferences
- Merge to IFC Model
- Detect IFC Model Changes
3. Modellera korrekt

3.1. Våningar
Gemensam våningsindelning och namngivning bör bestämmas så tidigt som möjligt i projektet. Om det inte finns någon projekteringsgrupp upprättad eller om inte andra discipliner är inblandade när projektet startas, bör arkitektens indelning av våningar vara utgångspunkt för andra discipliner.

Viktigt att tänka på:

- Bestäm våningars definition, rekommendationen är från överkant bjälklag till överkant bjälklag.
- Ha bara med de våningar som ska vara en del av byggnaden.
- Våningar ska inte användas som skissyta eller som tillfällig lagringsplats för alternativa lösningar.
- Lägg in våningar som andra discipliner har i sina modeller.
• Kontrollera alla höjder mot andra discipliners modeller innan utväxling av information sker.
• Terräng placeras på den våning som passar bäst, lämpligast på våning 0.
• Ta reda på hur andra discipliners applikationer hanterar våningar.

3.2. Vanliga fel
• ”Skräpgrafik” ligger kvar i modellen. Det kan även finnas väggbitar, bjälklag eller objekt som av misstag hamnat långt ifrån origo.
• Hela modellen ligger långt från origo.
• En kombination av punktarna ovan där både modellen och byggdelar ligger långt ifrån origo.
• Modellen innehåller för många objekt med komplex geometri. Det kan exempelvis vara 500 stolsobjekt med detaljer som armstöd, nackstöd och hjul, eller 1000 detaljerade dörrar med lås och handtag på båda sidor.
• Fel inställning eller nyttjande av själva IFC-översättaren. Alla objektekenskaper i biblioteket är inställda på Custom Property Set. Denna inställning betyder enorma mängder data, varav en mycket stor del är helt onödig.
• Geometri visas inte korrekt eftersom BREP (Boundary representation) inte har valts i översättaren.
• I de flesta projekt kan det kännas naturligt att spara en IFC-fil som är gemensam för alla discipliner. Det är dock viktigt att tänka på att minimera objekt såsom lös inredning, komplicerad terräng och växtlighet, bilar, människor och så vidare.
Modellen ska innehålla:

**Primärkonstruktioner:** väggar, bjälklag, pelare, balkar, tak, fönster, dörrar, trappor, räcken, skorstenar och zoner (utrymmen).

**Fast inredning:** Toaletter, handfat, garderober, köksinredning

I de fall lösa inredning och möblering behöver exporteras till IFC, ska detta göras i en separat fil.

### 3.3. Klassificering av bygdelar med BSAB-koder

3.4. Utrymmen/zoner (ifcSpace)
Utrymmen är kanske det enskilt viktigaste elementet i en BIM-modell. En felaktig mätning kan få stora konsekvenser för mängdning, men även vid en IFC-export.

Därför är det viktigt att, så långt det är möjligt, använda korrekt mätmetod för zoner. Manuella zoner är tidskrävande att skapa och uppdatera och ger sällan exakt area eller volym.

Uppmärksamma byggdelar som ligger inne i rummet, exempelvis pelare eller låga väggar som delar av rummet. Beroende på vilken typ av area som mäts kan det vara aktuellt att dra av denna yta.

Vid arbete med ytor är det även viktigt att kontrollera så att de stämmer och är uppdaterade. Det kan bland annat göras genom verktyget Design – Update Zones.

Det går även att kontrollera zoner visuellt i 3D genom att göra dem synliga genom Filter elements.
Egenskaper för utrymmen läggs till på samma sätt som för andra objekt under *Selection Settings – Classification and Properties*. 

Egenskap för rumsfunktion med BSAB-kod väljs från en värdelista (till höger i bild ovan). Den valda rumsfunktionen placeras sedan automatiskt i kopplade egenskapsfält. I bilden ovan är fältet *BSABs (BIP)* kopplat till rumsfunktionskoden 211.C. Eftersom egenskapen ligger under *IFC Properties* kommer informationen att visas vid en IFC-export.
3.5. Vägghöjder

3.6. Klassificering och ID-kodning av element

Klassificering är viktigt för att modellen ska kunna tolkas på ett korrekt sätt när IFC-information utväxlas. Särskilt i ett läge när modellen ska kontrolleras för mängdberäkning, energiberäkning eller ge korrekt information var byggdelarna är placerade i modellen.

De flesta BIM-verktygen har korrekt klassificering så att om en vägg är klassad som en vägg i ett verktyg, blir den automatiskt klassad som en vägg i ett annat.

![Slab Selection Settings](image)

För alla byggdelar bör följande kontrolleras:

- Att byggdelen tillhör en riktig våning under **Home Story**.
- Att den har en beskrivande struktur med Fill eller Composite.
- Att den har ett ID, som antingen består av en kod eller en beskrivning.
- Det ska finnas information om konstruktionen är bärande eller icke-bärande.
- Position, det vill säga om det är en exterier eller interiör byggdel.
- **BSAB-koder**.
- Att byggdelen är klassificerad på rätt sätt.
- Status på objektet, om det är nytt, befintligt eller rives.
- Byggdelarna ska så långt det är möjligt ligga på korrekt lager och modelleras med korrekt verktyg.
Det kan dock finnas situationer vid modellering när ett verktyg behöver användas för att modellera en helt annan byggdel. Se exempel nedan.
Ett räcke som är ritat med väggverktyget kommer slutligen att ha följande egenskaper tilldelade:

- IFC Element Type = railing
- Position = Exterior
- Structural Function = Non Load-Bearing Element

Andra situationer kan vara ett innertak som modelleras med bjälklagsverktyget. I alla förekommande fall ska objekten klassificeras till den korrekta byggdelen. På så sätt kommer rätt information vidare i en IFC-export och framtida analyser samt beräkningar får rätt förutsättningar.

Objektet Curtain Wall bör klassas som det element det kommer att beställas/byggas som, alltså vanligast fönster. Detta medför en bättre IFC-kommunikation med andra program.
3.7. Avancerad modelleringsteknik

ARCHICADs inställningar för IFC-import och -export är föränderliga i takt med att teknologin utvecklas, nedan listas några viktiga nya definitioner som hjälper till att strukturera upp vyerna på olika sätt – och kan användas i förberedande syfte för en IFC-export.

- IfcSystem-tilldelning(speciellt för MEP-element):
  - Gruppera projektelement i systemets hierarki manuellt genom att använda MEP Modellers definieringssystem, eller genom att importera systemen från MEP-applikationerna.
- Definiera undersystemhierarki ("förälder-" och "barn-"hierarki):
  - Gruppera hissar i ett vertikalt cirkulationssystem – kan även vara ett subsystem (s.k. "child") i förhållande till det mekaniska systemet.
  - Tilldela rör-/ledningselement till kallvattnets subsystem tillhörande ett rör-/ledningssystem.
- Multilevel ("Sub") hierarki för IfcZone- och IfcGroup-tilldelning.
  - Gruppera ARCHICAD-zoner (IfcSpaces) i en IfcZone (Security Zones), som dessutom kan vara en del av en IfcZone-grupp på högre nivå (Govermental Zones).
- Tilldela element direkt till en IfcSite eller en IfcBuilding.
  - Närliggande byggnader och bygplatssens elementsammanhang (exempelvis träd, staket och vägar,) kan tilldelas läget i stället för projektbyggnadens våningssystem.

Funktionen att systematisera och klassificera bygdelar är uppdaterad för ett effektivare arbetsflöde.

Mer information kan hittas via http://helpcenter.graphisoft.com och i Graphisoft Sveriges utbildningsmaterial.
4. IFC-import

4.1. Translators

Genom så kallade IFC-translators finns möjligheter att göra inställningar för både import och export från och till IFC-filer. Funktionen hittas under File > Interoperability > IFC > IFC Translators.

Translatorsn General Import importrar alla objekt som IFC har stöd för och är det alternativ som bör användas för de flesta IFC-filer. Det finns även translators som är specialanpassade för andra applikationer. Vad som skiljer beskrivs i fältet Description för respektive translator.

Till höger i bilden nedan ges även möjlighet att förändra inställningar för import och även skapa egna translators som har de egenskaper som önskas.
Olika translators har olika inställningar för hur geometrier ska exporteras till IFC.

**BREP Geometry**

*BREP* är en förkortning för *Boundary Representation* och en IFC-export med detta alternativ, ger en exakt återgivning av byggnadselementen. Alla *Solid Element Operations, trims, crops* och så vidare, kommer att visas korrekt i IFC-modellen. Se bild nedan.

Det är naturligtvis en fördel att grafik visas så som den är modellerad i originalapplikationen. Eftersom sättet att exempelvis koppla ihop element skiljer sig mellan applikationer, är en nackdel att det i vissa fall kan saknas parametrar i IFC-modellen.

**Extruded/Revolved Geometry**

Detta alternativ genererar en IFC-export med objektens originalutseende innan eventuella *SEO, trims* eller *crops*. Detta kan ibland vara en fördel när modellen ska editeras vidare i en annan applikation.
Bilden ovan visar nackdelarna tydligt när grafiken inte visar hur byggnaden egentligen ser ut. Det är därmed inte ett bra exportval i de fall modellen ska användas till exempel för kollisionskontroller.

4.1. Import Settings

Model Filter - öppnar fönstret Model Filter när användaren öppnar eller mergar en IFC-modell och ger möjligheter till override av translatorns standardinställningar.

![Model Filter for IFC Import](image)

Type Mapping - bestämmer vilket/vilka objekt som ska kopplas till respektive IFC-objekt.
Geometry Conversion

Styr inställningar för hur IFC-objekt konverteras till ARCHICAD-objekt vid import.
Rekommendationen är att konvertera importerad grafik till objekt eller morphs eftersom det oftast inte finns ett behov av att editera importerad grafik. På så sätt visas importerade objekt så som de var skapade i originalapplikationen.

Om det däremot finns ett behov av att visa importerad grafik på ett bättre sätt i plan- eller sektionsvy, kan det bli ett bättre resultat med Construction.
**Layer Conversion** - För konvertering av lager rekommenderas inställningen *Keep original layers and add extension*.

**Material and Surface Conversion** – Mappar importerade IFC-material till en skuren fyllning (Cut Fill) i ARCHICAD. Denna inställning rekommenderas om användaren vet att ARCHICADs fyllningar inte har samma namn som materialen i IFC-filen (gäller både File > Open och Merge).
Replace missing Renovation Status with

Funktion för att sätta status på objekt i modellen som saknar det.

4.2. Importera: Open and Merge

File > Open öppnar hela IFC-modellen eller filtrerade delar. ARCHICAD omvandlar de importerade elementen till motsvarande ARCHICAD-element. Merge (File > Interoperability > Merge) adderar ("mergar") IFC-modellen (hel eller filtrerad) i det öppna ARCHICAD-projektet och gör i det skedet om IFC-elementen till ARCHICAD-element.

Merge skapar alltid från och med ARCHICAD 16 nya ARCHICAD-element. Om det öppna projektet innehåller element med identiska (ifc-GUID) ID-nummer som element i den mergade modellen
kommer ARCHICAD att skapa nya element istället för att uppdatera de befintliga elementen. Anledningen är att skydda informationen i det öppna projektet.

Tips: Merge fungerar endast när användaren står i planvy i ARCHICAD. Tips: Spara alltid ARCHICAD-modellen innan IFC-modellen ”mergas”.

4.3. Importera IFC – steg-för-steg instruktion

1. Välj ”öppna”
2. Välj translator - Välj en av de translatorerna som kommer med vid installationen eller använd egendefinierade.
3. Välj IFC-format.
4. Välj IFC-modell att importera.
5. Välj ”öppna”. Filen läses in i ARCHICAD.

Obs: Element importerade genom Open eller Merge kan placeras på speciella lager i ARCHICAD (definieras i translatorn). Syftet är att separera importerade element från de befintliga i projektet.
5. IFC Export-inställningar

5.1. IFC Export Settings

Som nämntes i tidigare kapitel använder ARCHICAD en translator (översättare) för att öppna och spara IFC-modeller. Som syns i bilden nedan, är många av inställningarna och alternativen gemensamma för både import och export av IFC-modeller. Det finns dock några skillnader som visas nedan.
**IFC Schema** - Visar vilken version av IFC som ska användas. Det finns stöd för version IFC2x3 och IFC2x4 (den nyaste versionen).

**Model View Definition (MVD)** – Rekommendationer för vad en IFC-modell bör innehålla, beroende på vilket syfte modellen har. Det finns några fördefinierade MVD:er och de första som skapades genom Building Smart var Coordination View. De har som syfte att användare ska kunna utbyta information mellan alla stora discipliner (arkitekt, konstruktion, el, VVS etc). Objekten i modellen upptar en rumslig dimension för att exempelvis kunna möjliggöra kollisionskontroller. Byggnadsinformationen som utbyts, ska vara editerbar av den mottagande applikationen.

![IFC Schema Table]

**Property Mapping** – Här koplas särskilda egenskaper som ska exporteras inuti objekten. Det finns fördefinierade inställningar och det går att skapa egna kopplingar till egenskaper.
Data Conversion – Här väljs vilken data, förutom geometrier, som ska exporteras till IFC. Det kan vara data som är till nytta vid senare beräkningar, analyser eller utbyten av information i exempelvis fastighetssystem.
Unit Conversions – Inställningar för enheter.

5.2. Exportera: Save as IFC

Hela projektet eller filtrerade delar av projektet kan exporteras till IFC genom *File > Save as*. Under exportprocessen ”mappas” ARCHICAD-element enligt deras klassificering (automatiskt eller manuellt klassificering). På samma sätt som vid när IFC-filer öppnas, används translators när IFC sparas, samt möjligheten att filtrera modellen genom ”Model Filter”.

Steg-för-steg instruktion

1. Välj ”Save as”
2. Välj translator
3. Filtrera modell

Filtrera om det behövs -> knappen ”Model Filter” under vilken användaren kan välja att exempelvis exportera följande:

- Valda element (förutsätter att användaren har markerat element)
- Synliga element, alla våningar
- Synliga element aktuell våning (aktiv om du sparar från planvyn)
- Alla element, aktuell våning (aktiv om du sparar från planvyn)
4. Om det är aktuellt, filtrera element
5. Välj IFC-format

5.3. Export - använda ARCHICADs Publisher

Modellen kan exporteras med hjälp av Navigatorpalettens Publisher-läge. Det går att exportera hela modellen med ett enda klick eller få individuella filer för våningsplanen, beroende på Publisher Sets-inställningar. Alternativen för IFC Translator är tillgängliga via Publisher.
1. Aktivera Publisher-läget
2. Välj filformat
3. Välj IFC-translator
4. Välj sparad (filterad) arbetsvy; antingen en vy av 3D-modellen eller individuella våningsplan (eller en mapp innehållande våningsplan)
5. Välj publiceringsalternativ (this set / selected items)
6. Ställ även in sökvägen för de publicerade filerna (under Publisher Set).

Efter exporten är det klokt att kontrollera IFC-modellen i en IFC-browser för att säkerställa att elementen är rätt konverterade. Läs mer om detta i kapitel 8.

Solibri Model Viewer: [http://www.solibri.com](http://www.solibri.com)
Ytterligare information om IFC finns på: [http://www.ifcwiki.org](http://www.ifcwiki.org)
5.4.IFC Space Boundaries (zongränser)
Zonerna i ARCHICAD innehåller information som är användbar i exempelvis energiberäkningsprogram. Zoner är ur ett geometriskt perspektiv 3D-solider som omges av två bjälgklag och ett antal väggar.

Space Boundaries definierar den logiska kopplingen mellan ARCHICAD-zoner (IfcSpace) och byggnadselementen som omger zonen. I praktiken har alla byggeelement; väggar, pelare, balkar, fönster, dörrar, bjälgklag etc. olika energiegenskaper som behöver tas med i en energiberäkning.

Genom att aktivera ”IFC Space Boundaries” under exportinställningarna, kommer ARCHICAD att exportera alla zongränser samt deras relation (IfcRelSpaceBoundary) till zonen tillsammans med själva zonerna.

Med andra ord beräknar ARCHICAD position och storlek på de element som omger varje zon. ARCHICAD delar in zongränserna enligt deras areor, definierade och skurna med de element och öppningar som är kopplade till gränsen. Se figur nedan.

Inställningen Tolerance between Spaces avser maximalt avstånd mellan angränsande zoner. I praktiken kan användaren sätta en begränsning på elementets tjocklek (som ska tas med i beräkningen).

Beräkningar med Space Boundary fungerar endast om zonen skapats med geometrimetoden Inner Edge i ARCHICAD, se bild nedan.
5.5. Model Filter
Varje IFC translator innehåller generella inställningar för vilka element som ska importeras eller exporteras till IFC. Fönstret Model Filter (figur till höger) som kommer upp direkt vid export ger dig dock möjligheten att finjustera filtreringen enda ner på individuell elementnivå. Funktionerna i Model Filter varierar beroende på om det gäller import eller export av IFC-modellen.

Obs: Filtret ”By Structural Function” fungerar olika vid import och export:
- IFC import – filtret avser ”Load-Bearing”)
- IFC export – filtret avser klassificeringen ”Structural Function”.

Grid systems and elements
Markera detta för att inkludera Grid Elements och Gridmedlemmarna i Grid Systems i den exporterade filen. Gridelement kommer att dyka upp i IFC-strukturen som IfcGrid.

Lines, Texts, Labels, Fills
Markera det här för att exportera dessa 2D-element, samt alla dimensioner. 2D-elementen kommer att dyka upp i IFC-strukturen som IfcAnnotation. Dimensioner kommer att exploderas till rader och texter, eftersom IFC 2×3 standarddokumentationen inte innehåller ett dimensionselement. Notering: Om export sker från 3D-fönstret kommer 2D enbart exporteras om inställningen att hela projektet ska exporteras gjorts.

Door/Window 2D Views
Markera den här rutan för att inkludera 2D-symbolerna på dörrar och fönster i exportprocessen, förutom 3D-modellgeometri. Detta är praktiskt om mottagargprogrammet känner igen dessa data och kan presentera
informationen, till exempel dörröppningsriktningarna.

6. Fler IFC-funktioner
Avsnittet behandlar ytterligare IFC-inställningar, -funktioner och -verktyg för ARCHICAD-användare som redan kan grunderna i IFC.

6.1. Hotlink IFC
Från och med ARCHICAD 21 finns även alternativet att länka IFC-filer till ett ARCHICAD-projekt. Denna metod rekommenderas när externt material ska användas i projektet. Att kunna dela och använda modellinformation på detta sätt är mycket användbart under projekteringen. Ett sätt att dra nytta av funktionen är att länka repetitiva strukturer där det finns exempelvis en stor mängd identiska rum som i hotell eller kontorsbyggnader. Ett annat exempel är att länka in modeller från
andra discipliner för att se hur objekt fungerar i modellen. Funktionen finns under File > External Content > Place Hotlink.


![Diagram](image1)

6.2. Detect IFC Model Changes

*File > Interoperability > IFC > Detect IFC Model Changes...*

Funktionen gör det möjligt att jämföra två olika IFC-modeller. Det är en enkel form av revideringskontroll. Funktionen hittar automatiskt skillnader i geometri mellan två versioner av samma projekt och de element som ändrats införlivas ("mergas") i det aktuella projektet (som också kan vara ett helt tomt projekt). Ändringarna visas och hanteras i ARCHICADs verktyg Mark-Up (både 2D och 3D).
Normalt kan ändringskollen begränsas till del av modellen (exempelvis element på bottenvåningen) eller till vissa typer av element (exempelvis bara pelare). Eftersom de två modellversionerna har olika datum kan följande skillnader hittas automatiskt:

- Nya element
- Raderade element
- Modifierade element (position eller egenskaper)

De två versionerna måste vara gjorda med samma mjukvara och från samma projekt eftersom alla element identifieras med hjälp av deras guid (interna ID). Om de två IFC-versionerna kommer från olika program har alla element olika GUID och ändringskontrollen fungerar inte (allt betraktas som nytt...).

Ändringskontrollen hanterar inte 2D utan endast 3D-element (2D kommer att implementeras i nästa version av IFC).

Eftersom ändringarna ”mergas” in i den öppna ARCHICAD-modellen rekommenderas att projektet sparas innan.

**Tips:** Användaren kan också använda Detect Model Changes för att hitta förändringar mellan två ARCHICAD-modeller. Spara exempelvis två revideringar som IFC och använd Detect Model Changes...
En förutsättning för att det ska fungera är att elementet sparas med GUID vilket ställs in under IFC Options (beskrivs i kapitlet ”Avancerade IFC-kunskaper”).

6.3. Merge to IFC Model

Merge to IFC Model innebär att aktuell IFC-modell slås ihop med en befintlig. Merge låter användaren filtrera vilka element från det öppna projektet som ska sammanfogas med det befintliga (inte öppet).

Stegen för Merge är samma som för Save as med följande undantag:

- Merge kommer inte att skapa en ny fil utan sammanfogar ändringarna till den befintliga filen. Element som inte ändrats påverkas inte.
- GUID behålls alltid vid Merge (funktion som ger möjlighet att ge olika GUID vid varje IFC-export gäller alltså inte för Merge).

6.4. IFC Manager

IFC Manager visar strukturen i det öppnade projektets IFC-databas. Funktioner i IFC Manager:
• Lista entiteter hos elementen i det öppna ARCHICAD-projektet.
• Fråga efter IFC-attribut, properties och property sets tillagda till ARCHICAD-elementen.
• Editera IFC properties och property sets.
• Lägga till nya properties (utöver default) till IFC-entiteter för senare IFC-export.
• Skapa nya properties och custom property sets.
• Hitta element (IFC entities) både i ARCHICAD-modellen och i den skapade IFC-modellen.
• Navigera mellan ARCHICAD- och IFC-modellen.
• Uppdatera hela ARCHICAD-projektet med ändringar i IFC-modellen.
• Gruppera element och zoner.

IFC-strukturen visas övergripande i en trädstruktur (IfcProject > IfcSite > IfcBuilding > Ifc(Building)Story > IfcEntity) och listar IFC-entiteter individuellt enligt deras klassifikation i ARCHICAD (IFC Element Type).
Den högra delen av fönstret visar attribut och egenskaper för element markerat i vänstra delen.

Som tillägg till default IFC properties kan ytterligare properties enkelt läggas till för varje element: till exempel lägga till double glazing som en ny egenskap för fönster genom att skriva ”2” i fältet Value för Pset_DoorWindowGlazingType > GlassLayers property.

För att hitta element i strukturen med avseende på deras IFC GUID, skriv deras GUID eller del av det i fältet under Containment Structure och klicka på ”Search by GUID”. Välj något element i listan under sökfältet och markera, det kan hittas i strukturen ovanför.

6.5. Create New Property
För att skapa en ny IFC Property för en entitet (ARCHICAD-element) eller IFC Group, klicka på knappen Create New Property.
1. Skapa ett custom Property Set (Name of Property Set).
2. Skriv in den nya propertyns namn.
3. Välj typ av property i drop-downlistan.
4. Ange värden på property type.
5. För att lägga till ytterligare ny property till befintligt property set, klicka på New Property igen och välj ett befintligt property set från drop-downlistan och definiera ny property med namn, property type och value.

Tips: För att undvika fel, använd inte standard PSET-prefix när namnet skrivs in på det nya custom Property Setet.

6.6. Import Custom IFC Property Set
Detta kommando uppdaterar biblioteksdelens (objekt, dörr, fönster, skylight, zon, lampa) egenskaper i det öppna ARCHICAD-projektet med properties från vald IFC-fil genom att använda Custom Property Set configuration file.

Obs: Custom Property Set configuration måste genereras innan användaren använder Import Custom IFC Property Set (se IFC Options > Use configuration of extended library part items).

7. Kontroll och kvalitetssäkring
Kontroll och kvalitetssäkring är en viktig del av metodiken kring ett BIM-projekt. Det är viktigt både internt som kontroll av informationen i egna modeller och som kontroll av andra discipliners modeller. Nedan visas exempel på hur arbetet med kontroll av modeller kan gå till.
7.1.Viewer

7.2.Checker
En så kallad model checker har utvidgad funktionalitet beroende på användningsområde. Solibri Model Checker är unik i sitt slag när det gäller att kontrollera en BIM-modell. Med utgångspunkt från definierade regler och krav, skannar Solibri Model Checker igenom modellen automatiskt. På så sätt kan modellen kontrolleras så att informationen i den är korrekt i olika skeden av projekteringen.

Det finns andra Model Checkers som kan kontrollera byggnaden för kollisioner, men de är i stort sett begränsade till detta och är mer en Viewer än en Model Checker i egentlig mening.

7.3.ARCHICAD/Solibri Add-on

Länken mellan de båda programmen fungerar på följande sätt:

![Diagram](image)

Det går att stå i både planvy och 3D- vy, men vissa funktioner fungerar bara i 3D.

På samma sätt som vid IFC-export, förbereds modellen så att inga onödiga objekt ligger kvar i modellen.

När länken till ARCHICAD är etablerad kommer det fram en ny flik i ARCHICAD-menyn (SMC).

Om det är första gången som länken används behöver kopplingen till Solibri upprättas. Detta görs genom att sätta SMC launch folder till den plats på datorn där Solibri är installerat. Se bild nedan.
När detta är gjort är det bara att trycka på Export to SMC. Solibri öppnas automatiskt och behöver alltså inte startas på förhand.

Modellen är redo för kontroll.

I detta fall kan det vara naturligt att kontrollera om det finns några modelleringsfel som exempelvis dubbletter, men först görs en rundtur i modellen för att se om det finns några visuella fel.
För att gå vidare med detta placeras de aktuella elementen i **Selection Basket**. Därefter går vi tillbaka till ARCHICAD.

Vi väljer *Get selection basket* från SMC-menyn. Här görs val för vilken våning som ska importeras tillbaka och i detta exempel väljs alla våningar.
Här är ett tips att använda paletten *Selections* i ARCHICAD. Den hjälper oss att komma ihåg markeringar som vi vill titta närmare på för att sedan återgå till markeringen.
Här bör det ringa en varningsklocka. Vi har markerat tio pelare och det skulle bara vara fem. Något fel har gjorts i Solibri och vi får gå tillbaka dit för att se vad det kan vara.

Det är snabbt gjort och vi ser direkt att vi har valt alla pelare som filtrerades, inte bara dubbletternas.
Vi byter ut innehållet i *Selection Basket* mot bara dem som var dubbletter och går tillbaka till ARCHICAD. Denna gång blir det rätt och vi väljer att ta bort dubbletterna.
Det kan nu vara läge att lägga in en kommentar i Solibri om att avvikelsen har blivit korrigerad. Därefter kan vi fortsätta att kontrollera modellen.

Detta är ett exempel på en avvikelse som kan upptäckas i Solibri för att sedan korrigeras i ARCHICAD och vidare kommenteras i Solibri. Principen är densamma för olika frågeställningar som kan upptäckas.

Sammanfattningsvis sker arbetet med kontrollen på följande sätt:

1. För att använda länken i ARCHICAD ska modellen exporteras till Solibri.
2. Hitta det regelverk som passar det som ska kontrolleras (BIM validation).
3. Hitta dubbletter och lägg dessa i Selection Basket.
4. Skicka tillbaka dessa till ARCHICAD och ta bort dem.
5. Kommentera i Solibri att ändringen är genomförd.
7.4. Information i IFC-filer

Det är viktigt att ha klart för sig vilken information IFC hanterar och inte hanterar.

Information som exporteras vid användandet av IFC-formatet:

- Geometri
- Position
- Tillhörighet
- Information om:
  - Struktur
  - Brandklasser
  - Ljudklasser
  - Orientering med mera
- Egendefinierad information läggs till som property sets om behov finns
- Material
- Mängder.

Information som inte exporteras vid användandet av IFC-formatet:

- Ritningskontorets mall och layoutstruktur
- Objektbibliotek
- Favoriter
- Andra applikationsbunda inställningar
7.5. BIM Collaboration Format


7.5.1. Exempel BCF-kommunikation
Det finns många olika tänkbara scenarion där modeller behöver verifieras under exempelvis en byggprojektering. I detta exempel förklaras det förmodligen vanligaste tillvägagångssättet. Vi utför en enkel kontroll av en relativt stor modell som är skapad i ARCHICAD. I exemplet nedan är vi både den som utför kontrollen, sändare av IFC-modellen och mottagare av BCF-rapporten.

Tillvägagångssätt:

1. Exportera ARCHICAD-modellen till IFC-formatet.
2. Importera modellen i Solibri Model Checker.

![Create Report](image)

6. Importera BCF-filen i ARCHICAD via BCF-Manager.

![Import BCF](image)


8. Åtgärda problemet.
På detta sätt löses problem som annars skulle ha kunnat åsämka skada vid framtida hantering. I detta exempel kunde en för stor volym av bjälklaget justeras, vilket ledde till en mer korrekt mängdavtagning för miljöberäkning av betong.
8. IFC – rekommendationer (Best practice)

8.1. Arbetsflöde IFC-Export från ARCHICAD

Övergripande behöver fastställas: Var i koordinatystemet modellen ska skapas, åt vilket håll norr pekar och hur våningarna ska definieras. Vidare finns det följande grundläggande inställningar i modellen som ska bestämmas:

- Definiera vad som är bärande och icke-bärande element.
- Definiera om elementen är utvändiga eller invändiga.
- Klassificera alla element enligt standard.
- Se över alla nödvändiga IFC-egenskaper som ska finnas i projektet.

1. Organisera element:
   - Kontrollera att alla element i modellen är kopplade till korrekta lager.
   - Göm lager som inte är intressanta för mottagaren av IFC-filen.
   - Spara en lagerkombination som lagrar inställningarna.
   - Spara en 3D-vy av projektet som använder den tidigare lagerinställningen. Detta underlättar för användaren att växla mellan IFC- och projekteringsvy.

2. Koordinater och orientering – Faktiska koordinater:
   - Modellera nära ARCHICADs origo.
   - Modellera vinkelrätt och med jämna värden.
   - Skapa en ny ARCHICAD-modell där byggnaden ska ritas i faktiska koordinater. Definiera även våningarna till korrekt koordinatsystem.
   - Länka in byggnaden som skapades i steg 1 ovan via funktionen Hotlink.
   - Placera byggnaden på rätt koordinater i modellen (X/Y).
   - Rotera Hotlink-modulen så att den är relaterad korrekt mot norr.
   - Exportera till IFC med alternativet At Project Origin (IFC Translator > Export Options > Geometry Conversion Options).
3. Våningar

Det är viktigt att samordna våningar med andra projektmedlemmar och med andra discipliner så att inga missförstånd sker vid informationsutbytet. Nedan visas en typisk inställning för hantering av våningar.

För hantering av våningar i faktiska koordinater:
- Justera höjderna så att de passar riktiga koordinater i Z-led.
- När byggnadsmodellen länkas in via Hotlink, kommer den att hamna på rätt plats höjdsmässigt.
4. Zoner
- Modellera zoner med *Inner Edge Construction Method*

- Manuellt skapade zoner är tidskrävande att skapa och kan inte uppdateras via *Update Zones Command* (Design Menu > Update Zones). Förutom att det lätt kan bli fel vid manuell hantering, kan det även påverka beräkningar inuti zon-förteckningar.
- Manuella zoner kan dessutom orsaka import-fel för Revit-användare som får felmeddelandet *ARCHICAD zones may be reported as room is not in a properly enclosed region*.
- Detta felmeddelande kan även visas i Revit om inställningen *Subfloor Thickness* inte är satt till 0.

8.2. Arbetsflöde IFC-Import till ARCHICAD

Nedan visas en metod som underlättar import och ger en bra struktur med hjälp av *Hotlink IFC File*.


1. File > External Content > Place Hotlink.
2. Välj IFC-format i dialogrutan och en translator för import.
3. Välj *Options* för att se en sammanfattning av den valda translatorns inställningar, eller för att välja en translator från en annan mallfil.
4. Välj *Select* för att återgå till dialogrutan *Place Hotlink*.
5. Välj *Place Hotlink*.
6. Välj var objekten (library parts) ska sparas.

![Image](image.png)
8.2.1. Hantera attribut för importerade IFC-filer
När en IFC-fil importeras med alternativet Convert to construction elements, otherwise objects/morphs, kommer attribut att skapas i ARCHICAD-filen. Dessa är mestadels komplexa profiler och byggnadsmaterial. För enklare hantering är det en bra idé att se över vilka profiler som skapats och hur de är namngivna. Profilerna markerade i bilden nedan är komplexa profiler från IFC-filen.

8.3. Multidisciplinära projekt
Multidisciplinära projekt har flera utmaningar och med rätt metodik finns mycket att vinna på att använda IFC-formatet i BIM-samordningen.
Att informationsutbytet fungerar i denna typ av projekt är viktigt. Alla programvaror som hanterar byggnadsmodellen ska kunna exportera till IFC-formatet på ett korrekt sätt.

Vid ett BIM-startmöte där alla berörda projektdeltagare deltar, behöver följande hanteras:

- Beställarens kravspecifikationer för dokumentation och leveranser.
- Särskilda riktlinjer för BIM som är specifikt för projektet.
- Vilka programvaror som ska användas. En metodik för informationsutbytet tas fram.
- Hur ska modellen struktureras? Fungerar exempelvis strukturen, indelningar för alla parter?
  - Katalogstrukturer
  - Projektets nollpunkt
  - Våningars definition
  - Objektegenskaper
  - ObjektID
  - Med mera
- Informationsutbytet mellan parter och i olika skeden dokumenteras.
- Vilka leveransdatum finns i projektet?
- Koordinera kvalitetskontroller och hur problem i modellen ska hanteras.
- Gör en plan för 3D-samgranskning
8.3.1. 3D-samgranskning med hjälp av IFC-formatet


Denna kvalitetskontroll ska vara fortlöpande i projektet och utförs både av respektive projektörs BIM-samordnare och hela projektets samordnare. Det ska dessutom ske kontroller i form av 3D-samgranskning vid de leveranskedden som finns.
